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คําถามที่พบบ่อย: 
● ตัวเลขครัวเรือนยากจนและคนจนต่างๆ ที่แสดงบนระบบ TPMAP แต่ละตัวเลขมี

หมายความว่าอย่างไร เช่น
○ ครัวเรือนที่ได้รับการสํารวจ (จปฐ.)
○ ครัวเรือนยากจน (จปฐ.)
○ คนที่ได้รับการสํารวจ (จปฐ.)
○ คนยากจน (จปฐ.)
○ คนจนเป้าหมาย
○ คนจนสุขภาพ
○ คนจนความเป็นอยู่
○ คนจนการศึกษา
○ คนจนรายได้
○ คนจนการเข้าถึงบริการภาครัฐ

● จะหาครัวเรือนและรายชื่อคนจนเหล่านัน้จากระบบ TPMAP Logbook ได้อย่างไร
2



ตัวอย่างคําถามที่ได้รับจากจังหวัด: 

จังหวัดต้องการทราบ จํานวน และ รายชื่อ คนจนเป้าหมายใน
แต่ละด้าน จากข้อมูล TPMAP เพ่ือมอบหมายให้หน่วยงานที่
เกี่ยวข้องดูแล เช่น
● จํานวนและรายชื่อคนจนเป้าหมายด้านรายได ้เพ่ือใหพ้ช.จังหวัดดูแล

● จํานวนและรายชื่อคนจนเป้าหมายด้านสุขภาพ เพ่ือใหส้ธ.จังหวัดดูแล

● จํานวนและรายชื่อคนจนเป้าหมายด้านความเป็นอยู ่เพ่ือใหพ้ม.จังหวัดดูแล

● จํานวนและรายชื่อคนจนเป้าหมายด้านการศึกษา เพ่ือใหศ้ธ.จังหวัดดูแล
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ข้อมูลที่ระบบ TPMAP และ TPMAP Logbook มีค่าตรงกัน
TPMAP: จํานวนครัวเรือนที่ได้รับการสํารวจ (จปฐ.)

ครัวเรือนที่ได้รับการสํารวจ (จปฐ.) 7,908 ครัวเรือน

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

เว็บไซต์ TPMAP
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ครัวเรือนที่ได้รับการสํารวจ (จปฐ.) 7,908 ครัวเรือน

ไม่ต้องคลิกเลือก

ข้อมูลที่ระบบ TPMAP และ TPMAP Logbook มีค่าตรงกัน
TPMAP Logbook: จํานวนครัวเรือนที่ได้รับการสํารวจ (จปฐ.) สามารถดูได้จากจํานวนรายการที่แสดงในหน้าข้อมูลครัวเรือน

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที
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“คนจนเป้าหมาย” ของระบบ TPMAP คือใคร
คนจนเป้าหมายของระบบ TPMAP คือ คนที่มีคุณสมบัติตรงตามเงื่อนไขทั้ง 2 ข้อ ดังนี้

☑ 1. เป็นคนที่อยู่ใน ครัวเรือนจปฐ. ที่ตกดัชนี MPI* = ตกข้อใดข้อหนึ่งใน 17 ข้อ จปฐ.

☑ 2. เป็นคนทีถ่ือบัตรสวัสดิการแห่งรัฐ กระทรวงการคลัง

* ครัวเรือนจปฐ. ที่ตกดัชนี MPI  = ครัวเรือนจปฐ. ที่ตกข้อใดข้อหนึ่งใน 17 ข้อ จปฐ. ดังต่อไปนี้

1. เด็กแรกเกิดมีนํ้าหนัก 2,500 
กรัมขึ้นไป
4. ครัวเรือนกินอาหารถูก
สุขลักษณะ ปลอดภัย และได้
มาตรฐาน
5. ครัวเรือนมีการใช้ยาเพ่ือ
บําบัด บรรเทาอาการเจ็บป่วย
เบื้องต้นอย่างเหมาะสม
7. คนอายุ 6 ปีขึ้นไป ออกกําลัง
กายอย่างน้อยสัปดาห์ละ 3 วัน 
วันละ 30 นาที

8. ครัวเรือนมีความมัน่คงในที่อยู่
อาศัย และบ้านมีสภาพคงทน
ถาวร
9. ครัวเรือนมีนํ้าสะอาดสําหรับดื่ม
และบริโภคเพียงพอตลอดปีอย่าง
น้อยคนละ 5 ลิตรต่อวัน
10. ครัวเรือนมีนํ้าใช้เพียงพอ
ตลอดปี อย่างน้อยคนละ 45 ลิตร
ต่อวัน
11. ครัวเรือนมีการจัดการ
บ้านเรือนเป็นระเบียบเรียบร้อย 
สะอาด และถูกสุขลักษณะ

15. เด็กอายุ 3-5 ปี ได้รับบริการ
เลี้ยงดูเตรียมความพร้อมก่อน
วัยเรียน
16. เด็กอายุ 6-14 ปี ได้รับการ
ศึกษาภาคบังคับ 9 ปี
17. เด็กจบชัน้ ม.3 ได้เรียนต่อชัน้ 
ม.4 หรือเทียบเท่า
19. คนอายุ 15-59 ปี อ่าน เขียน
ภาษาไทย และคิดเลขอย่างง่าย
ได้

20. คนอายุ 15-59 ปี มีอาชีพและ
รายได้
21. คนอายุ 60 ปีขึ้นไป มีอาชีพ
และรายได้
22. รายได้เฉลี่ยของคนใน
ครัวเรือนต่อปี

27. ผู้สูงอายุ ได้รับการดูแลจาก
ครอบครัว ชุมชน ภาครัฐ หรือ
ภาคเอกชน
28. ผู้พิการ ได้รับการดูแลจาก
ครอบครัว ชุมชน ภาครัฐ หรือ
ภาคเอกชน

ด้านสุขภาพ ด้านความเป็นอยู่ ด้านการศึกษา ด้านรายได้ ด้านการเข้าถึงบริการรัฐ
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ครัวเรือนยากจน MPI 71 ครัวเรือน

(คือ ครัวเรือนที่ตกตัวชี้วัดจปฐ. ข้อใดข้อหนึ่งใน 17 ข้อที่ใช้ในการ
คํานวณดัชนีความยากจนหลายมิติ: MPI)

ข้อมูลที่ระบบ TPMAP และ TPMAP Logbook มีค่าตรงกัน
TPMAP: จํานวนครัวเรือนยากจน MPI

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

เว็บไซต์ TPMAP
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คลิกเพ่ือเลือกครัวเรือนยากจน MPI

ข้อมูลที่ระบบ TPMAP และ TPMAP Logbook มีค่าตรงกัน
TPMAP Logbook: จํานวนครัวเรือนยากจน MPI สามารถดูได้จากจํานวนรายการที่แสดงในหน้าข้อมูลครัวเรือน

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

ครัวเรือนยากจน MPI 71 ครัวเรือน

(คือ ครัวเรือนที่ตกตัวชี้วัดจปฐ. ข้อใดข้อหนึ่งใน 17 ข้อที่ใช้ในการ
คํานวณดัชนีความยากจนหลายมิติ: MPI)
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คนที่ได้รับการสํารวจ (จปฐ.) 22,087 คน

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

คนจน MPI 210 คน

(คนที่อยู่ในครัวเรือนจปฐ. ที่ตกตัวชี้วัดจปฐ. ข้อใดข้อหนึ่งใน 17 ข้อ ที่
ใช้ในการคํานวณดัชนีความยากจนหลายมิติ: MPI)

คนจนเป้าหมาย 90 คน

(คนที่ถือบัตรสวัสดิการแห่งรัฐ และ อยู่ในครัวเรือนจปฐ. ที่ตกดัชนี MPI)

คําถาม: ข้อมูลคนที่ได้รับการสํารวจ (จปฐ.) คนจน MPI และ คนจนเป้าหมาย
              ตามที่แสดงจํานวนในระบบ TPMAP อยู่ตรงไหนในระบบ TPMAP Logbook

เว็บไซต์ TPMAP
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ไม่ต้องคลิกเลือก

คําถาม: ข้อมูลคนที่ได้รับการสํารวจ (จปฐ.) คนจน MPI และ คนจนเป้าหมาย
              ตามที่แสดงจํานวนในระบบ TPMAP อยู่ตรงไหนในระบบ TPMAP Logbook
คําตอบ: สามารถนําข้อมูลออกจากหน้าข้อมูลครัวเรือน (หน้าค้นหา) ของ TPMAP Logbook 
               ในรูปแบบ CSV ไปวิเคราะห์ต่อด้วยโปรแกรม Excel, OpenOffice, Numbers หรืออื่นๆ

นําออกข้อมูลในรูปแบบ CSV
(สามารถนําออกข้อมูลได้ครังละไม่เกิน 10,000 ครัวเรือน)

TPMAP Logbook
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ไฟล์ CSV (Comma-Separated Values) จาก TPMAP Logbook
เมื่อเปิดด้วยโปรแกรม Text Editor เช่น Notepad, TextEdit

ไฟล์ CSV คือ Text File สําหรับเก็บข้อมูลแบบตาราง โดยใช้เครื่องหมาย comma (,) แบ่งข้อมูลในแต่ละ Column
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ข้อควรระวัง: ในคอมพิวเตอร์บางเครื่อง เมื่อดับเบิลคลิกเพ่ือเปิดไฟล์ CSV 
โปรแกรม Excel จะถูกเปิดขึ้นมาให้โดยอัตโนมัติ แต่อาจจะมกีารแสดงผลที่ผิดพลาด 

ตัวอย่างการแสดงผลที่ผิดพลาด เช่น โปรแกรม Excel ตีความ ข้อมูลบ้านเลขที่ เป็น ข้อมูลวันที่
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วิธีการนําเข้าไฟล์ CSV ไปใช้งานในโปรแกรม Excel ที่ถูกต้อง
เลือกเมนู “Data” > From Text > Delimited > Unicode (UTF-8) > Comma

13



กําหนดชนิดของข้อมูลแต่ละ Column ให้ถูกต้อง

ใน Column บ้านเลขที่ ให้กําหนดเป็น “Text” เพ่ือป้องกันไม่ให้โปรแกรม Excel ตีความข้อมูลบ้านเลขที่ เป็น ข้อมูลวันที่
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เมื่อกําหนดชนิดข้อมูลแต่ละ Column ให้ถูกต้อง 
โปรแกรม Excel จะสามารถแสดงผลไฟล์ CSV ได้อย่างถูกต้อง

โปรแกรม Excel

ข้อสังเกต: หากนําเข้าไฟล์ CSV ด้วยโปรแกรม Excel ได้อย่างถูกต้อง จํานวนแถว (Row) ที่แสดงในโปรแกรม Excel จะมีค่า
เท่ากับ จํานวนรายการในระบบ TPMAP Logbook บวก 1 (บวก 1 เนื่องจากบรรทัดแรกใน Excel คือ บรรทัดหัวตาราง)

TPMAP Logbook

1 แถว (Row) = 1 ครัวเรือน
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คนที่ได้รับการสํารวจ (จปฐ.) 22,087 คน

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

กลับมาที่คําถาม: วิธีการคํานวณจํานวนคนที่ได้รับการสํารวจ (จปฐ.) 
ตามที่แสดงจํานวนในระบบ TPMAP จากไฟล์ CSV ที่ได้จากระบบ TPMAP Logbook

เว็บไซต์ TPMAP
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วิธีการ Freeze บรรทัดหัวตาราง 
คลิกที่ cell “A2” > Window > Freeze Panes

โปรแกรม Excel

วิธีการคํานวณจํานวนคนที่ได้รับการสํารวจ (จปฐ.) 
ไปที่ cell ล่างสุดของ Column “จํานวนสมาชิกในบ้าน” และพิมพ์สูตร 

= SUM(K2:K7909)

ตําแหน่ง Cell บนสุดของ Column นัน้ 
(ที่ไม่ใช่บรรทัดหัวตาราง)

ตําแหน่ง Cell ล่างสุดของ Column นัน้ 

(ในกรณีที่เรามีข้อมูลจํานวนแถวเยอะมาก เมื่อเราเลื่อนลงมาทํางานกับข้อมูลแถวล่างๆ จะไม่เห็นหัวตารางว่าแต่ละ Column คือข้อมูลอะไร  
การ Freeze บรรทัดหัวตารางไว้ จะช่วยให้เราทํางานง่ายขึ้น)
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วิธีการคํานวณจํานวนคนที่ได้รับการสํารวจ (จปฐ.) 
ไปที่ cell ล่างสุดของ Column “จํานวนสมาชิกในบ้าน” และพิมพ์สูตร > กด Enter

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

คนที่ได้รับการสํารวจ (จปฐ.) 22,087 คน

โปรแกรม Excel

เว็บไซต์ TPMAP

กด Enter

จํานวนคนที่ได้รับการสํารวจ (จปฐ.) บนระบบ TPMAP จะมีค่า
เท่ากับที่คํานวณด้วยโปรแกรม Excel จากข้อมูลไฟล์ CSV ที่
นําออกจากระบบ TPMAP Logbook
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ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

ในทํานองเดียวกัน วิธีการคํานวณจํานวนคนจนเป้าหมาย
ตามที่แสดงจํานวนในระบบ TPMAP จากไฟล์ CSV ที่ได้จากระบบ TPMAP Logbook

คนจนเป้าหมาย 90 คน

(คนที่ถือบัตรสวัสดิการแห่งรัฐ และ อยู่ในครัวเรือนจปฐ. ที่ตกดัชนี MPI)

เว็บไซต์ TPMAP
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วิธีการคํานวณจํานวนคนจนเป้าหมาย 
ไปที่ cell ล่างสุดของ Column “จํานวนคนจนเป้าหมาย TPMAP” และพิมพ์สูตร > กด Enter

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

โปรแกรม Excel

เว็บไซต์ TPMAP

กด Enter

จํานวนคนจนเป้าหมาย บนระบบ TPMAP จะมีค่าเท่ากับที่
คํานวณด้วยโปรแกรม Excel จากข้อมูลไฟล์ CSV ที่นําออก
จากระบบ TPMAP Logbook

= SUM(R2:R7909)

บนสุดของ
Column
(ไม่นับหัวตาราง)

ล่างสุดของ
Column

คนจนเป้าหมาย 90 คน

(คนที่ถือบัตรสวัสดิการแห่งรัฐ และ อยู่ในครัวเรือนจปฐ. ที่ตกดัชนี MPI)
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ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

คําถาม: ยังเหลือตัวเลข จํานวนคนจน MPI ตามที่แสดงจํานวนในระบบ TPMAP 
คํานวณอย่างไร จากไฟล์ CSV ที่ได้จากระบบ TPMAP Logbook

คนจน MPI 210 คน

(คนที่อยู่ในครัวเรือนจปฐ. ที่ตกตัวชี้วัดจปฐ. ข้อใดข้อหนึ่งใน 17 ข้อ ที่
ใช้ในการคํานวณดัชนีความยากจนหลายมิติ: MPI)

เว็บไซต์ TPMAP
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จํานวนคนจน MPI  = จํานวนสมาชิกในครัวเรือนจปฐ. ที่ตกตัวชี้วัดจปฐ. 
                                    ข้อใดข้อหนึ่งใน 17 ข้อ ที่ใช้ในการคํานวณดัชนี MPI

 จากข้อมูลในไฟล์ CSV จะมี Column ที่เกี่ยวข้อง 2 Column ได้แก่
1. จํานวนหมวดความยากจนที่ตก (MPI)
2. จํานวนสมาชิกในบ้าน

วิธีคิด: ถ้าบ้านไหน มี จํานวนหมวดความยากจนที่ตก (MPI) ตัง้แต่ 1 หมวดขึ้นไป จะนับ
จํานวนสมาชิกในบ้าน นัน้ทัง้หมด เป็นคนจน MPI
แปลงเป็นสูตร Excel: 

= IF (จํานวนหมวดความยากจนที่ตก (MPI) >= 1, จํานวนสมาชิกในบ้าน, 0)

โปรแกรม Excel
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วิธีการคํานวณจํานวนคนจน MPI

1. สร้าง Column เปล่า (คลิกที่ Column ที่ต้องแทรก คลิกขวา > Insert)

2. พิมพ์สูตรลงไปในช่อง L2 เพ่ือคํานวณจํานวนคนจน MPI ของครัวเรือนแรก
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วิธีการคํานวณจํานวนคนจน MPI

3. นําเมาส์ไปวางมุมล่างขวาของ L2 ให้ขึ้นเป็นเครื่องหมาย + 
แล้วดับเบิลคลิกทีเ่ครื่องหมาย + จะเป็นการ Copy สูตรลงไปที่แถวด้านล่างทัง้หมด

+
ดับเบิลคลิก
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วิธีการคํานวณจํานวนคนจน MPI
4.   ไปที่ cell ล่างสุดของ Column “จํานวนคนจน MPI” ที่เพ่ิงสร้างขึ้นมา > พิมพ์สูตร > Enter

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

โปรแกรม Excel

เว็บไซต์ TPMAP

กด Enter

จํานวนคนจน MPI บนระบบ TPMAP จะมีค่าเท่ากับที่คํานวณ
ด้วยโปรแกรม Excel จากข้อมูลไฟล์ CSV ที่นําออกจากระบบ 
TPMAP Logbook

= SUM(L2:L7909)

บนสุดของ
Column
(ไม่นับหัวตาราง)

ล่างสุดของ
Column

คนจน MPI 210 คน
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ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

คําถาม: ข้อมูลคนจนเป้าหมายในแต่ละด้าน
              ตามที่แสดงจํานวนในระบบ TPMAP อยู่ตรงไหนในระบบ TPMAP Logbook
คําตอบ: สามารถวิเคราะห์ได้จากไฟล์ CSV ที่นําออกจากหน้าข้อมูลครัวเรือน (หน้าค้นหา) 
               ของระบบ TPMAP Logbook ได้เช่นเดียวกัน

เว็บไซต์ TPMAP

คนจนเป้าหมายในแต่ละด้าน
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ความหมายของ Column “ตกเกณฑ์ยากจนด้าน… (MPI)” ในไฟล์ CSV เดิม

โปรแกรม Excel

ในไฟล์ CSV จะมี Column ที่ชื่อว่า “ตกเกณฑ์ยากจนด้าน… (MPI)” จํานวน 5 Column แยกตามด้านต่างๆ ของดัชนี MPI
ได้แก่ ด้านสุขภาพ, ด้านความเป็นอยู่, ด้านการศึกษา, ด้านรายได้ และด้านการเข้าถึงบริการรัฐ ซึ่งจะมีค่าเป็น 0 หรือ 1 เสมอ

ความหมาย:  0 = ครัวเรือนในแถว (Row) นัน้ ผ่านเกณฑด์้านดังกล่าว
 1 = ครัวเรือนในแถว (Row) นัน้ ตกเกณฑด์้านดังกล่าว
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วิธีการคํานวณจํานวนคนจนเป้าหมายในแต่ละด้าน
ตัวอย่างการคํานวณจํานวนคนจนเป้าหมายด้านความเป็นอยู่

ข้อสังเกต    คนจนเป้าหมายของระบบ TPMAP คือ คนที่มีคุณสมบัติตรงตามเงื่อนไขทัง้ 2 ข้อ ดังนี้

☑ 1. เป็นคนที่อยู่ใน ครัวเรือนจปฐ. ที่ตกเกณฑ์ยากจนด้านใดด้านหนึ่ง และ.

☑ 2. เป็นคนที่ถือบัตรสวัสดิการแห่งรัฐ กระทรวงการคลัง

ตัวอย่าง 1  ครัวเรือนหนึ่งมีสมาชิกในบ้านจํานวน 7 คน มีผู้ถือบัตรสวัสดิการแห่งรัฐ 3 คน ครัวเรือนนี้ตกเกณฑ์ยากจนด้านความเป็นอยู่
                       ถามว่าครัวเรือนนี้มีจํานวนคนจนเป้าหมายด้านความเป็นอยู่กี่คน (คําตอบ: 3 คน)

ตัวอย่าง 2  ครัวเรือนหนึ่งมีสมาชิกในบ้านจํานวน 7 คน มีผู้ถือบัตรสวัสดิการแห่งรัฐ 3 คน ครัวเรือนนี้ผ่านเกณฑ์ยากจนด้านความเป็นอยู่
                        ถามว่าครัวเรือนนี้มีจํานวนคนจนเป้าหมายด้านความเป็นอยู่กี่คน (คําตอบ: 0 คน)

ตัวอย่าง 3  ครัวเรือนหนึ่งมีสมาชิกในบ้านจํานวน 7 คน ไม่มีผู้ถือบัตรสวัสดิการแห่งรัฐเลย ครัวเรือนนี้ตกเกณฑ์ยากจนด้านความเป็นอยู่
                        ถามว่าครัวเรือนนี้มีจํานวนคนจนเป้าหมายด้านความเป็นอยู่กี่คน (คําตอบ: 0 คน)

สรุปวิธีคิด: ถ้าบ้านไหน ตกเกณฑ์ยากจนด้านความเป็นอยู ่จะนับจํานวนผู้ถือบัตรสวัสดิการ
แห่งรัฐ ทัง้หมดในบ้านนัน้ เป็น คนจนเป้าหมายด้านความเป็นอยู่
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วิธีการคํานวณจํานวนคนจนเป้าหมายในแต่ละด้าน
ตัวอย่างการคํานวณจํานวนคนจนเป้าหมายด้านความเป็นอยู่

สรุปวิธีคิด: ถ้าบ้านไหน ตกเกณฑ์ยากจนด้านความเป็นอยู ่จะนับจํานวนผู้ถือบัตรสวัสดิการแห่งรัฐ 
ทัง้หมดในบ้านนัน้ เป็น คนจนเป้าหมายด้านความเป็นอยู่

แปลงเป็นสูตร Excel: 

= IF(ตกเกณฑ์ยากจนด้านความเป็นอยู่ (MPI) = 1, จํานวนผู้ถือบัตรสวัสดิการแห่งรัฐ, 0)
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วิธีการคํานวณจํานวนคนจนเป้าหมายในแต่ละด้าน
ตัวอย่างการคํานวณจํานวนคนจนเป้าหมายด้านความเป็นอยู่
สรุปขั้นตอน: (ทําแบบเดียวกับตัวอย่างที่แล้ว)
1. สร้าง Column เปล่า สําหรับคํานวณจํานวนคนจนเป้าหมายด้านความเป็นอยู่ ในแต่ละบ้าน
2. พิมพ์สูตรการคํานวณจํานวนคนจนเป้าหมายด้านความเป็นอยู่ สําหรับบ้านแรกในแถว (Row) ที่ 2
3. นําเมาส์ไปวางมุมล่างขวาของ Cell ที่ใส่สูตรเอาไว้ของบ้านแรก ให้ขึ้นเป็นเครื่องหมาย + จากนั้นดับเบิลคลิกที่

เครื่องหมาย + เพ่ือ Copy สูตรใส่ให้ทุกบ้าน
4. ไปที่ Cell ล่างสุดของ Column ที่เพ่ิงสร้างขึ้นใหม่ แล้วใส่สูตร = SUM(บ้านแรก:บ้านสุดท้าย) เพ่ือหาผลรวม
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วิธีการคํานวณจํานวนคนจนเป้าหมายในแต่ละด้าน
ทําแบบเดียวกับด้านสุขภาพ/ด้านการศึกษา/ด้านรายได้/ด้านการเข้าถึงบริการรัฐ

ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

คนจนเป้าหมายในแต่ละด้าน

โปรแกรม Excel

เว็บไซต์ TPMAP ตัวอย่าง: จ. สมุทรสงคราม อ.บางคนที

จํานวนคนจนเป้าหมายในแต่ละด้าน
บนระบบ TPMAP จะมีค่าเท่ากับที่
คํานวณด้วยโปรแกรม Excel จาก
ข้อมูลไฟล์ CSV ที่นําออกจากระบบ 
TPMAP Logbook
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โจทย์: ต้องการข้อมูลบ้านและรายชื่อหัวหน้าบ้านที่ในบ้านมี
           คนจนเป้าหมายแต่ละด้าน เพ่ือมอบหมายให้หน่วยงานที่เกี่ยวข้องดูแล

ตัวอย่าง ต้องการข้อมูลบ้านที่มคีนจนเป้าหมายด้านความเป็นอยู่
    1. เลือกเมนู “Data” > Filter > จะปรากฎเครื่องหมายลูกศรเล็กๆ ที่บรรทัดหัวตาราง 
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โจทย์: ต้องการข้อมูลบ้านและรายชื่อหัวหน้าบ้านที่ในบ้านมี
           คนจนเป้าหมายแต่ละด้าน เพ่ือมอบหมายให้หน่วยงานที่เกี่ยวข้องดูแล

ตัวอย่าง ต้องการข้อมูลบ้านที่มคีนจนเป้าหมายด้านความเป็นอยู่
    2. คลิกที่ลูกศรเล็กๆ ที่ Column ที่ต้องการกรองข้อมูล
    3. คลิกเครื่องหมาย ✓ ข้างหน้า 0 เพ่ือไม่ให้โปรแกรมแสดงผลบ้านที่ไม่มีคนจนเป้าหมายด้านความเป็นอยู่

ผลลัพธ์ที่ได้ คือ ข้อมูลบ้านและรายชื่อหัวหน้าบ้านที่ในบ้านมคีนจนเป้าหมายด้านความเป็นอยู่
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ขอบคุณค่ะ

Q & A
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